
 

Infographic Designer Quick Start 
 

Infographic Designer is a Power BI custom visual to provide infographic presentation of data. For 

example, using Infographic Designer, you can create pictographic style column charts or bar 

charts as shown in Fig. 1. Unlike standard column charts or bar charts, they use a single icon or 

stacked multiple icons to constitute a column or bar.  

Icons convey the data concepts in concrete objects, and the size and number of icons can 

represent data quantities intuitively. Research reveals that such infographics can improve the 

effectiveness of visualizations by making data quickly understood and easily remembered. As a 

result, they are getting popular and have been widely adopted in the real world.  

Now with Infographic Designer, you are able to create infographic visuals in Power BI easily. 
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Fig. 1. Example infographics created by Infographic Designer 



 

Overview 
 

Infographic Designer visual is structured as a small multiple, where each individual view is a 

chart of a particular chart type (Fig. 2). Currently it supports column chart, bar chart, and card 

chart. More chart types (line chart, scatter chart, etc.) will be added in the future. In Fig. 2, A is a 

small multiple of card chart, and B is a small multiple of column chart. As a special case, when a 

small multiple comes to 1X1, it is identical to a single chart (see the charts in Fig. 1). 
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 Fig. 2. Infographic Designer small multiples 



 

For the individual views of the small multiple, Infographic Designer allows you to customize the 

chart marks to achieve beautiful, readable, and friendly visualizations. Marks are the graphics to 

represent individual data points on a chart. Standard column charts or bar charts use rectangle 

as chart mark. In Infographic Designer, you can replace it with more rich and more compelling 

visual elements. 

In report Editing View, when hovering mouse over a Infographic Designer visual, you will notice 

there is a “Edit Mark” button on the top-left corner (Fig. 3A). Click this button to bring up the 

Mark Designer pane (Fig. 3B) docked to the right side of the visual, where you can edit the chart 

mark. As the Mark Designer occupies some space within the visual, it is recommended that you 

open the visual in the Focus mode to edit its marks when its size is not large enough.  
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Fig. 3. Open the Mark Designer to edit chart mark 



 

A chart mark is composed with one or multiple visual elements. Infographic Designer supports 

three kinds of visual elements: 

 Shape (Icon) 

A shape or icon is essentially a SVG path. Infographic Designer provides a set of built-in 

shapes, which are organized into several categories. You are also allowed to upload an 

icon from a SVG file.     

 Image 

Images uploaded from image files are supported, including both raster images 

(.PNG, .JPEG, .BMP, etc.) and vector images (.SVG).  

 Text 

Single-line text boxes can be added to a mark. 

In the Mark Deisgner, you can add or remove different visual elements to compose a chart mark. 

For each element, you specify its format and layout properties as appropriate to make your mark 

compelling.  

For a shape (icon) or image element, you can choose to display it in either single unit or multiple 

units. When using single unit, only one shape or image is presented; otherwise, multiple shapes 

or images are stacked in a grid. 

For example, in Fig. 1B, the column mark is customized as a composition of a shape element and 

a text element, where the shape element is shown in single unit with various icon heights 

representing differnet measure values of corresponding data points on the chart. The icons in 

Fig. 1C are also in single unit. Each icon are in same size, but with different highlighted portions. 

The heights of highlighted portions represent the corresponding measure values. In Fig. 1A and 

Fig. 1D, the icons are used in multiple units. You can compare the measure values of different 

data points based on the length or percentage of highlighted portion in multiple units. 

Infographic Designer supports data-binding for some element attributes. For example, as shown 

in Fig. 1D and Fig. 2B, you can assign different icons for each value in Category dimension. In 

Fig. 2A, different colors are specified based on the dimension values. Infographic Designer only 

supports binding to categorical fields (dimensions) currently. Data-binding of numerical fields 

(measures) will be added in the future. 

Infographic Designer visuals work well with other Power BI visuals on the same report or 

dashboard. Upon the selection from other visuals, Infographic Designer will update with data 

filtered accordingly. On the other hand, you can select one or more data points in Infographic 

Designer by clicking on corresponding marks (press Ctrl to select more) to filter or highlight 

other Power BI visuals.           



 

Configure Small Multiple 
 

You can specify small multiple settings in the Visualization Pane. 

Arrangement  

The arrangement of a small multiple is determined upon: 

 Row Dimensions: a set of dimensions to define the categories used to split the small 

multiple vertically. 

 

 Column Dimensions: a set of dimensions to define the categories used to split the 

small multiple horizontally. 

The Row Dimensions could be empty. In that case, the small multiple only has one row. The 

Column Dimensions could be empty too. In that case, the small multiple only has one column.   

For the small multiple in Fig. 2A,  it has no row dimensions, and one column dimension 

Category. For the one in Fig. 2B, it has one row dimension FiscalMonth, and one column 

dimension Territory. 

Fig. 4 shows the settings UI for assigning Row Dimensions and Column Dimensions; as well as 

the data fields used in the individual charts.   

  

(A) Chart Fields: 

fields and their roles used in the individual charts  

 

(B) Column By: 

fields used as Column Dimensions of small multiple 

 

(C) Row By: 

fields used as row dimensions of small multiple 

Fig. 4. Field settings of Infographic Designer visual 



 

When clicking to select a field in the Fields Pane, Infographic Designer will automatically assign a 

role for this field. You can also drag a field from the Fields Pane to a specific setting area in Fig. 4 

as you need, or move a field between the Row By list, the Column By list, and the Chart Fields 

area by drag-and-drop to modify the field settings of a Infographic Designer visual. 

For example, the Infographic Designer visual in Fig. 5A is a single column chart.  By dragging the 

field Territory and moving it to the Column By list, the visual is changed to a small multiple of 

card charts accordingly, as shown in Fig. 5B.  

(A)   

(B)  

Fig. 5. Infographic Designer visual changed with field setting changes 



 

Layout 

Infographic Designer provides two layout modes for placing individual charts within a small-

multiple row: 

 Flow mode 

Charts belonging to a small-multiple row can be placed on multiple lines. When the 

number of charts exceeds a pre-defined limit a line, new charts will be flowed to a new 

line. Fig. 2A is an example of small multiples in flow mode, where each line is maximized 

to 4 charts. 

 Matrix mode 

All charts belonging to a small-multiple row are placed on a single line. The small multiple 

shown in Fig. 2B is laid out as matrix.  

Fig. 6 shows the layout settings UI for the small multiple. You can choose the layout mode from 

the Layout Mode list box. For flow mode, you can use the Max Row Width edit box to specify 

how many charts can be contained in a line. You can determine whether to show the row and 

column headers by selecting the On/Off of the Show Header option, and whether to show the 

sperators by selecting the On/Off of the Show Seperators option.  

 
(A) Flow mode 

 
(B) Matrix mode 

Fig. 6. Small multiple layout settings 



 

Chart Formatting 

In the Visualizations pane, select Format tab and expand the options for chart formatting as 

shown in Fig. 7.  

You can select the chart type as you need from the Type list 

box. Available chart types depend on the data fields you 

have assigned.  

You can format your chart axes. For example, for a column 

chart or bar chart, you are able to show or hide X-Axis, Y-

Axis, and grid lines by toggling corresponding options in the 

UI. 

You can modify the gaps between the chart area and the 

boundary of corresponding small multiple region by 

specifying proper padding values in the Top Padding, 

Bottom Padding, Left Padding, and Right Padding edit boxes. 

Fig. 8 gives an illustration of these paddings.      
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Fig. 7. Chart format settings 



 

Customize Chart Marks 
 

Mark Designer UI  

As you see from Fig. 9, the Mark Designer pane can be divided into three areas: Toolbar, 

Preview, and Format/Layout. 

 
 

 

<- Toolbar 

<- Preview 

<- Format/Layout 

Fig. 9. Mark Designer pane 

The Toolbar area contains UI controls for managing elements on the mark. Specificlly, from left 

to right, there are: 

(1) a button to insert a shape (icon) element; 

(2) a button to insert a text element; 

(3) a button to insert an image element; 

(4) a list box of all elements, from which you can select one as current element; 

(5) a button to adjust the z-order of the selected element; 

(6) a button to delete the selected element; and 

(7) a button to toggle showing all elements or only showing the selected one in the preview.    



 

The Preview area provides a preview of the mark. The frame of mark bounds is shown in gray 

line, and the bound of the selected element is highlighted with dot line. You can click on an 

element to select it. 

The Format/Layout area is the place for you to edit the current element (the selected one). You 

can view and modify its format settings by clicking the Format tab, or its layout settings by 

clicking the Layout tab.   

Insert New Elements  

When clicking the button to insert a new shape (icon) element, an Icon Selection dialog will pop 

up (see Fig. 10). In this dialog, you can select an icon from the built-in icon library, or click the 

Upload button to load a new one from a SVG file.  

As shown in Fig. 10, the built-in icons 

are orgainized as several categories, 

and each category is listed in a 

corresponding tab in the dialog. The 

uploaded icons will be added to a 

special tab named as “Uploaded”, 

which is the last tab. Select one icon 

(either built-in one or uploaded one), 

and click to add it to the mark.  

To add a new image element, 

similarly you need to select an image 

from the Image Selection dialog. 

There is no built-in image library so 

far, so you are required to click the 

Upload button to load images from external image files. The uploaded images appear in 

“Uploaded” tab, the only tab in the dialog.  Select one and click to add it to the mark. 

Adding a new text element is simple. Just click the corresponding button, a new text element will 

be added to the mark with default settings. 

Edit Element Formats  

You can view and modify the formats of current element in the Format tab. As you see from Fig. 

11, different element types have different format settings.  

For a text element, you can edit the text content, and specify various properties regarding to 

appearance of the text, including text color, font, font size, and horizontal and vertical alignment.  

 
Fig. 10. Icon Selection dialog 

 



 

Format settings for a shape element and an image element are similar, including: 

- modify the element content by selecting a different shape or image 

- select to render the shape or image in single unit or multiple units 

- for multiple units, specify the arrangement of unit rows and columns 

- highlight the percentage of a selected measure field    

 
(A) Shape 

 
(B) Image 

 
(C) Text 

Fig. 11. Element formats 

Multiple Units Arrangement 

For a shape or image element, turn Multiple Units option to “On” if you want to render it in 

multiple units. Multiple units will be arranged as a matrix, so you need to specify how many units 

will be placed along the row and column directions. Infographic Designer provides two 

properties for you to set rows and columns (see Fig. 12 for an illustration): 

- For Card chart and Column chart: Row Count and Units Per Row 

- For Bar chart: Column Count and Units Per Column 

For each property, Infographic Designer allows you to specify it as a number or “Auto”. For 

specifying a number, select the corresponding slider to set it as “Custom”, and input a number in 

the edit box. For specifying “Auto”, just select the corresponding slider to set it as “Auto”. See 

the examples in Fig. 11.  



 

When one property is set as “Auto”,  Infographic Designer will automatically calculate the 

numbers for you to well fit the units.       

 
 

(A) Card chart 

 

 
(B) Column chart 

 

 
(C) Bar chart 

Fig. 12. Rows and columns for multiple units 

 

Fill Percentage 

For a shape or image element, you can assign a measure to it by selecting a measure field from 

the Fill Percentage list box.  Select “none” from the listbox if you want to remove such binding. 



 

When assigned a measure, no matter in single unit or multiple units, a shape or image element 

will highlight the percentage of the measure value of current data point according to the max 

measure value on the chart, using two colors. 

As shown in Fig. 13, for a shape, you can specify a Value Color and a Non-Value Color to fill the 

shape into two parts. The percentage of the Value Color part gives you an understanding how 

current value compares to the max value.  

Image element is similar. You can specify a Value Tint and a Non-Value Tint to tint two parts to 

show the percentage of current value according to the max value. 

 
 

 

Fig. 13. Fill percentage with two colors 



 

Data Binding 

For each property that supports data binding, you will see a corresponding data-binding button 

on the right side of the property setting UI (Fig. 14A). The data-binding button uses different 

images to indicate whether the data binding is set or not (Fig. 14B). 

 

 
(A) data-binding button 

 

 
data-binding OFF 

(data-binding is not set) 

 
data-binding ON 

(data-binding is set) 

(B) data-binding status 

 

 
(C) data-binding of shape 

 
(D) data-binding of color 

 

 
(E) remove data-binding 

Fig. 14. Data binding 



 

Click the button to modify data binding in a sub-pane. You can select a data field to do the data 

binding. For example, you can bind shapes to a field and assign different shapes for different 

field values (Fig. 14C), or you can bind the color to a field and assign different colors for different 

field values (Fig. 14D). If you want to remove the data binding, just select the data binding field 

as none (Fig. 14E).  

Click Back to apply the settings and return back to the high-level pane. 

Edit Element Layout 

Infographic Designer allows you to specify the position 

and the size of current element in the Layout tab. As 

shown in Fig. 15, the UI provides an illustration with 

various icons and annotations to help you adjust the 

layout parameters. 

For an element, its position and size are both measured 

according to the mark boundary. A mark may have 

multiple boundaries. As illustrated by Fig. 16, each 

column mark or bar mark has two boundaries: Inner 

Bound and Outer Bound. The Inner Bound corresponds 

to the values of individual data point, while the Outer 

Bound corresponds to the data point with the max value 

on the chart. 

So first of all, you need to select a mark boundary from 

the Bound to list box. The layout of current element will be calculated based on the selected 

mark bound.  

 

Fig. 16. Mark boundaries 

 
Fig. 15. Layout UI 



 

The element layout is determined based on below parameters: 

 Top Distance, Bottom Distance, Left Distance, and Right Distance: the distance 

between the top/bottom/left/right edges of the mark and the element. 

 Top Lock, Bottom Lock, Left Lock, and Right Lock:  whether the Top/Bottom/Left/Right 

Distance should be locked or not 

 Element Width and Height 

On the layout illustration (see Fig. 15), the dot-line frame represents the mark boundary, while 

the gray rectangle represents the element boundary.  

There are 4 icons on the mark boundary to indicate Top Lock, Bottom Lock, Left Lock, and Right 

Lock, respectively. You can click these icons to toggle the On/Off of corresponding locks.  

There are 4 labels between the mark and the element, which annotate the values of Top 

Distance, Bottom Distance, Left Distance, and Right Distance. You can click on a label to modify 

the corresponding distance value, using either abosulte measurement (in pixels) or relative 

measurement (in percentages of the mark bound). 

There are 2 lables within the element bound, which annotate the valudes of element width and 

element height. Similarly, you can click on a lable to modify the corresponding value in either 

pixels or percentages of the mark bound.  

By tweaking these parameters, you are able to achieve desired layout for the selected element: 

Its vertical position and size are depended on Top Distance, Element Height, and Bottom 

Distance. For a unlocked distance, its value will be ignored (labelled as “auto” on the UI). When 

both distances are locked, the Element Height value will be ignored.  

Similarly, its horizontal position and size are depended on Left Distance, Element Width, and 

Right Distance. When both distances are locked, the Element Width value will be ignored. 

Otherwise the unloked distance(s) will be ignored. 

By default, the four distances are locked with zero values, which means that the element will be 

stretched in the selected mark bound. 

 

Please let us know your questions, suggestions, and feedback. Send us 

email: infonice@microsoft.com 

 


